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Renesas RA Family 

Migrating Projects to New FSP Version 
Introduction 
This section describes the steps to migrate an existing RA Project to a newer FSP pack version, and then 
build and run the example project. The procedure in this migration guide applies to all RA devices and 
evaluation kits, and all software listed in the Required Resources section. 

Required Resources 
• An RA evaluation kit (for example, EK-RA6M3) 
• A PC running Microsoft® 10 with the following Renesas software installed as required: 

 Flex Software Package (FSP) v1.0.0 or greater 
 e2 studio ISDE v7.6.0 or greater 
 RA Smart Configurator (RASC) v7.6.0 or greater 
 IAR EW for ARM v8.50.1 or greater 
 Keil MDK (v5.29 or higher) and ARM compiler 6 (version 6.13 or higher) 
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1. Installing Latest FSP Packs 
A. e2 studio 

This can be done in two ways: 
 Download and install the latest FSP with e2 studio Installer (for example, 

setup_fsp_x_x_x_e2s_x_x.exe). This should be done if the e2 studio version has changed. 
 Download and run the latest FSP pack installer (for example, FSP_Packs_x.x.x.exe) and browse 

to the folder where e2 studio is installed. 
 

 

Figure 1.   Choosing Install Location in e2 studio 

B. Keil and IAR 
This can be done in two ways: 
 Download and install the new RASC (for example, setup_fsp_x_x_x_rasc_x_x.exe) with the 

latest FSP pack version. 
 Download and run the latest FSP pack installer (for example, FSP_Packs_x.x.x.exe) and browse 

to the folder where RASC is installed. 

 

Figure 2.   Choosing Install Location in Keil and IAR 

C. Additional steps: 
a. IAR: To use RASC with EWARM, latest RASC needs to be configured as a tool in EWARM by 

selecting the menu item Tools > Configure Tools. 
Command: Select Browse... and navigate to rasc.exe in the installed RA SC. 

b. Keil: Import the latest RA device pack. (for example, MDK_Device_Packs_x.x.x.zip). 
Extract the archive file to locate the RA device pack. To import the RA device pack, launch the 
PackInstaller.exe from <keil_mdk_install_dir>\UV4. Select the menu item File > 
Import... and browse to the extracted .pack file. 
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2. Migrating Project in e2 studio 
2.1 Migrating an Existing Project in e2 studio 
1. Start by opening e2 studio. 
2. Follow the steps below to launch the workspace. 

A. At the end of e2 studio startup, you see the e2 studio Launcher dialog box as shown in Figure 3. 

 

Figure 3.   e2 studio Launcher Dialog Box 

B. If you do not see the dialog box, you might have turned it off. If this is the case, open your desired 
project and skip to step D. Otherwise, continue with the following steps. 

C. Enter a new workspace name in the e2 studio Launcher dialog box. 
D. Click Launch. 
E. When the workspace is opened, you may see the Welcome window. 

3. You are now in the workspace that you want to import the project into. Click File in the menu bar. 

 

Figure 4.   File Menu Bar in the Workspace 

4. Click Import on the File drop-down menu. 

 

Figure 5.   Selecting Import Option in the File Menu 
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5. In the Import dialog box shown in the figure below, select the General option, and then select Existing 
Projects into Workspace to import the project into the current workspace. 

 

Figure 6.   Selecting Workspace to Import Existing Projects 

6. Click Next. 
7. Click Select archive file or Select root directory if project is already extracted and click Browse. 

 

Figure 7.   Selecting Archive File or Root Directory 

8. Browse to the folder where the zip/extracted file for the project you want to import is located. 
9. Select the file for import. For the purpose of illustration gpt_ek_ra6m3_ep.zip is used in this 

document. 
10. Click Open. 
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11. Select the project to import from the list of projects. 

 

Figure 8.   Selecting the Project to Import 

12. Click Finish to import the project. 
13. Now that the project has been successfully imported, you can start configuring the project to migrate for 

the hardware. 
14. Open the RA Configuration, by double-clicking the configuration.xml file in the Project Explorer. 

   

Figure 9.   Opening the RA Configuration using configuration.xml 

15. After clicking, a dialog box may appear to migrate the project to latest FSP version. Click OK. 
16. If not, click on BSP tab and choose the appropriate FSP version from drop down as shown. 

 

Figure 10.   Choosing the FSP Version from the BSP Tab 



Renesas RA Family Migrating Projects to New FSP Version 

R20AN0583EU0100  Rev.1.00  Page 6 of 1 
Sep.15.20  

2.2 Generating the Project Files in e2 studio 
1. In the RA Configuration window, save the configuration and click the Generate Project Content button. 

 

Figure 11.   Clicking the Generate Project Content Button 

2. The project should resemble the folder structure and the project is ready to build. 

 

Figure 12.   Folder Structure for the Ready to Build Project 

2.3 Building and Running the Project  
Refer to the section “Tutorial: Your First RA MCU Project – Blinky” in FSP Documentation for steps on 
building and running the project. 

https://renesas.github.io/fsp/_s_t_a_r_t__d_e_v.html#tutorial-your-first-ra-mcu-project-blinky
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3. Migrating a Project in Keil µVision  
3.1 Migrating an Existing Project in Keil µVision 
1. Start by unzipping the example project, gpt_ek_ra6m3_ep.zip and open the project in file explorer. 
2. Open the Keil project by double clicking the µVision project file as shown in Figure 13. 

 

Figure 13.   Opening the Keil Project 

3. After opening the project, you should see the project structure as shown in Figure 14. 

 

Figure 14.   Project Structure 

4. Now click on  to open Manage Run-time Environment tab. 



Renesas RA Family Migrating Projects to New FSP Version 

R20AN0583EU0100  Rev.1.00  Page 8 of 1 
Sep.15.20  

5. Click the green run button next to RA Configuration in the Flex Software tree as shown in Figure 15. 

 

Figure 15.   Clicking the Green Button for RA Configuration in the Flex Software Tree 

6. If multiple versions of RASC are installed, select the appropriate version of RASC to run. 

 

Figure 16.   Selecting the Appropriate Version of RASC to Run 

7. RASC will be launched with project generator wizard. 
8. A dialog box may appear to migrate the project to latest FSP version. Click OK. 

  

Figure 17. Notification Regarding FSP Version 
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3.2 Generating the Project Files in Keil µVision 
1. The configuration window opens once the project wizard is closed. 
2. In the RA Configuration window, click the Generate Project Content button. 

 

Figure 18.   Clicking the Generate Project Content Button 

3. After clicking Generate Project Content in the RA Smart Configurator, return to µVision. µVision offers a 
dialog box to import the changes and updates to the project made in RASC. Select Yes to import the 
updated project and the project is ready to build. 

 

Figure 19.   Importing Changes and Updates in the µVision Window 

4. RASC will place the necessary FSP source code and header files into the project workspace. 
 
3.3 Building and Running the Project 
Refer to the section “Using RA Smart Configurator with Keil MDK” in FSP Documentation for steps on 
building and running the project. 

https://renesas.github.io/fsp/_s_t_a_r_t__d_e_v.html#using-ra-smart-configurator-with-keil-mdk
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4. Migrating Project in IAR EWARM 
4.1 Migrating an Existing Project in IAR EWARM 
1. Start by unzipping the example project, gpt_ek_ra6m3_ep.zip, and open the project in file explorer. 
2. Open the IAR project by double clicking the IAR project file as shown in Figure 20. 

 

Figure 20.   Opening the IAR Project File 

3. After opening the project, you should see the project structure as shown in Figure 21. 

 

Figure 21.   Project Structure 

4. RASC can now be launched from EWARM using the menu item Tools > RA Smart Configurator. 

 

Figure 22.   Launching the RA Smart Configurator from EWARM 
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5. RASC will be launched with project generator wizard. 
6. A dialog box will appear to migrate the project to latest FSP version. 

  

Figure 23.   Migrating the Project to the Latest FSP Version 

7. Click OK. 
 
4.2 Generating the Project Files in IAR EWAR 
1. The configuration window opens once the project wizard is closed. 
2. In the RA Configuration window, click the Generate Project Content button. 

 

Figure 24.   Clicking the Generate Project Content 

8. After clicking Generate Project Content in the RA Smart Configurator, return to IAR EWARM. 
9. Changes to the RA configuration will be reflected in the EWARM project. 
 
4.3 Building and Running the project 
Refer to FSP Documentation for steps on building and running the project. 

 

  

https://renesas.github.io/fsp/
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Website and Support 
Visit the following vanity URLs to learn about key elements of the RA family, download components and 
related documentation, and get support. 

RA Product Information  www.renesas.com/ra  
RA Product Support Forum  www.renesas.com/ra/forum  
RA Flexible Software Package www.renesas.com/FSP 
Renesas Support  www.renesas.com/support 
  

 

  

http://www.renesas.com/ra
https://www.renesas.com/ra/forum
http://www.renesas.com/FSP
https://www.renesas.com/support
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Notice 
1. Descriptions of circuits, software and other related information in this document are provided only to illustrate the operation of semiconductor products 

and application examples. You are fully responsible for the incorporation or any other use of the circuits, software, and information in the design of your 
product or system. Renesas Electronics disclaims any and all liability for any losses and damages incurred by you or third parties arising from the use 
of these circuits, software, or information. 

2. Renesas Electronics hereby expressly disclaims any warranties against and liability for infringement or any other claims involving patents, copyrights, 
or other intellectual property rights of third parties, by or arising from the use of Renesas Electronics products or technical information described in this 
document, including but not limited to, the product data, drawings, charts, programs, algorithms, and application examples.  

3. No license, express, implied or otherwise, is granted hereby under any patents, copyrights or other intellectual property rights of Renesas Electronics 
or others. 

4. You shall not alter, modify, copy, or reverse engineer any Renesas Electronics product, whether in whole or in part. Renesas Electronics disclaims any 
and all liability for any losses or damages incurred by you or third parties arising from such alteration, modification, copying or reverse engineering. 

5. Renesas Electronics products are classified according to the following two quality grades: “Standard” and “High Quality”. The intended applications for 
each Renesas Electronics product depends on the product’s quality grade, as indicated below. 
 "Standard": Computers; office equipment; communications equipment; test and measurement equipment; audio and visual equipment; home 

electronic appliances; machine tools; personal electronic equipment; industrial robots; etc. 
 "High Quality": Transportation equipment (automobiles, trains, ships, etc.); traffic control (traffic lights); large-scale communication equipment; key 

financial terminal systems; safety control equipment; etc. 
Unless expressly designated as a high reliability product or a product for harsh environments in a Renesas Electronics data sheet or other Renesas 
Electronics document, Renesas Electronics products are not intended or authorized for use in products or systems that may pose a direct threat to 
human life or bodily injury (artificial life support devices or systems; surgical implantations; etc.), or may cause serious property damage (space 
system; undersea repeaters; nuclear power control systems; aircraft control systems; key plant systems; military equipment; etc.). Renesas Electronics 
disclaims any and all liability for any damages or losses incurred by you or any third parties arising from the use of any Renesas Electronics product 
that is inconsistent with any Renesas Electronics data sheet, user’s manual or other Renesas Electronics document. 

6. When using Renesas Electronics products, refer to the latest product information (data sheets, user’s manuals, application notes, “General Notes for 
Handling and Using Semiconductor Devices” in the reliability handbook, etc.), and ensure that usage conditions are within the ranges specified by 
Renesas Electronics with respect to maximum ratings, operating power supply voltage range, heat dissipation characteristics, installation, etc. Renesas 
Electronics disclaims any and all liability for any malfunctions, failure or accident arising out of the use of Renesas Electronics products outside of such 
specified ranges. 

7. Although Renesas Electronics endeavors to improve the quality and reliability of Renesas Electronics products, semiconductor products have specific 
characteristics, such as the occurrence of failure at a certain rate and malfunctions under certain use conditions. Unless designated as a high reliability 
product or a product for harsh environments in a Renesas Electronics data sheet or other Renesas Electronics document, Renesas Electronics 
products are not subject to radiation resistance design. You are responsible for implementing safety measures to guard against the possibility of bodily 
injury, injury or damage caused by fire, and/or danger to the public in the event of a failure or malfunction of Renesas Electronics products, such as 
safety design for hardware and software, including but not limited to redundancy, fire control and malfunction prevention, appropriate treatment for 
aging degradation or any other appropriate measures. Because the evaluation of microcomputer software alone is very difficult and impractical, you are 
responsible for evaluating the safety of the final products or systems manufactured by you. 

8. Please contact a Renesas Electronics sales office for details as to environmental matters such as the environmental compatibility of each Renesas 
Electronics product. You are responsible for carefully and sufficiently investigating applicable laws and regulations that regulate the inclusion or use of 
controlled substances, including without limitation, the EU RoHS Directive, and using Renesas Electronics products in compliance with all these 
applicable laws and regulations. Renesas Electronics disclaims any and all liability for damages or losses occurring as a result of your noncompliance 
with applicable laws and regulations. 

9. Renesas Electronics products and technologies shall not be used for or incorporated into any products or systems whose manufacture, use, or sale is 
prohibited under any applicable domestic or foreign laws or regulations. You shall comply with any applicable export control laws and regulations 
promulgated and administered by the governments of any countries asserting jurisdiction over the parties or transactions. 

10. It is the responsibility of the buyer or distributor of Renesas Electronics products, or any other party who distributes, disposes of, or otherwise sells or 
transfers the product to a third party, to notify such third party in advance of the contents and conditions set forth in this document. 

11. This document shall not be reprinted, reproduced or duplicated in any form, in whole or in part, without prior written consent of Renesas Electronics. 
12. Please contact a Renesas Electronics sales office if you have any questions regarding the information contained in this document or Renesas 

Electronics products. 

(Note1) “Renesas Electronics” as used in this document means Renesas Electronics Corporation and also includes its directly or indirectly controlled 
subsidiaries. 

(Note2) “Renesas Electronics product(s)” means any product developed or manufactured by or for Renesas Electronics. 
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Corporate Headquarters  Contact information 
TOYOSU FORESIA, 3-2-24 Toyosu, 
Koto-ku, Tokyo 135-0061, Japan 
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 For further information on a product, technology, the most up-to-date 
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